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Each student at the College has their own individual login account for the College 
computer network. In order to access your account, you need a Username and 
Password.  Initially this will be set as:   

 

     Username =   Enrolment Number 

     Password =   Date of Birth 
 
 
Note: For password purposes, your date of birth is entered as a six figure number - for 

example the 8th October 1980 would be entered as 081080 
 

Step-By-Step First Login 

All college PCs start-up with a Novell Login Box, as shown below.  If you do not see this 
screen – ask your tutor. 

 
 

Enter your Username (enrolment number) as shown below. 
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Press the Tab ( ) key.  Then enter your date of birth e.g. 081080. This will appear as a 
row of circles – one per character that you have typed in.  
 

 
 
Use the mouse to click on ADVANCED and make sure that the Context box is set to 
Students.NNR.HTC. If not, then click on the arrow at the end of this box and select the 
correct option from the drop-down list. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Use the mouse to click on OK and wait for the computer to continue logging in. 
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Changing Passwords 

Once you have accessed your account, you will be prompted to change your password 
with the following message and must do so – or you will be locked out of the College 
computer system.   

 

To change your password, select Yes as shown above.  This will take you to the following 
screen where you can set your new password.   

 
 

Passwords should be at least six characters long and can contain both letters and 
numbers.  Try to choose a password that you will find easy to remember!  You username 
will remain as your enrolment number.  
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Enter your new password as shown below.  This will appear as a row of circles – one per 
character that you have typed in.  
 

 
 
Press the Tab ( ) key.  Then type your new password again as shown bellow to make 
sure that you spelt it correctly.  Again, this will appear as a row of circles – one per 
character that you have typed in.  
 

 
 

Use the mouse to click on OK and then wait for the machine to login. 
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Setting Challenge Response Questions 

Once you have logged in for the first time and changed your password, you will be 
prompted to answer two Challenge Response Questions.  These are security questions 
which will allow you to reset your password should you forget it in the future.  If you do not 
do this, you will not be able to access the system should you forget your password! 
 

 
 

To set your Challenge Response Questions select OK when prompted which will take you 
to the first question screen. 
 

 
 

Enter your mother’s maiden name as requested and select Next.  
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This will take you to the second question screen. 
 

 
 

Enter your place of birth as requested and select Finish.  
 

 
 

You should now see the following message confirming that your Challenge Response 
Questions have been set. 

 

 
 

Use the mouse to click on OK and wait for the computer to continue logging in. 
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Re-Setting Your Password 

If you forget your login password and have previously answered the Challenge Response 
Questions, you can reset your own password by selecting the Did you forget your 
password? option from the login screen as shown below. 

 

 

Select OK to reset your password when prompted as shown below.   

 

 
 

This will take you to the first question screen. 
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Enter your place of birth as requested and select OK.  
 

 
 

This will take you to the second question screen. 
 

 
 

Enter your mother’s maiden name as requested and select OK.  
 

 



                                                                                                    IT SUPPORT UNIT 

Individual Student Login Accounts – 

How To Login 

Student Network Handout                                                                                                              2008/2009   9

You should now see the change password screen and be able to reset your password in 
the same manner as before.  

 

 
 

 
 
 
 
 
 
 
 
 
 

 
 

Enter your newly set password into the login box. 
 

 
 

Use the mouse to click on OK and wait for the computer to continue logging in. 
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Accessing the Internet 

To access the Internet in College, you must first be logged into a computer using your own 
College user account.  You can then access the Internet via Internet Explorer, but will 
need to enter your username (enrolment number) and network login password into the 
initial Internet Explorer screen before you can browse the Internet.   

 

The College monitors and records the Internet usage of all users. 
 
 

All student computer login accounts, email accounts and 
their contents will be deleted at the end of the 

College’s Academic Year 
on 1st July 2009. 
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H:\ Drive Usage 

Your student login account has a 200Mb network work area, reserved for your use.  This is 
mapped as a H:\ drive when you login to a computer and can be accessed within College 
through My Computer, Windows Explorer, or by selecting the H:\ option from the drop-
down list when opening/saving files within applications. 

 

You are responsible for the content of your network work area (H:\ drive) and 
for the regular backup of your data.  Backups can be taken by copying 

the contents of your H:\ drive to a USB pen drive (data stick) on 
a regular basis.  Pen drives are available at a reasonable 

charge from the College bookshop. 
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Accessing H:\ Drive through the Internet 
Your H:\ drive can also be accessed through the Internet from outside the College.  This 
can be achieved by opening a Web Browser (e.g. Internet Explorer) and going to the 
following site. 

http://portal.kirkleescollege.ac.uk 

From here, select the College H Drive link from the list on the left hand side of the screen 
and this will transfer you to the H:\ drive login screen.  If prompted by a security alert as 
shown below, select Yes to continue. 
 

 

This will take you to the NetStorage login screen, as shown below. 

 

In order to access your H:\ drive, you will need to enter a Username and Password and 
then click on OK.  Your H:\ drive username and password are: 

 
 Username   = .EnrolmentNumber.students.nnr.htc 

 Password   = Novell Login Password 

Remember:  For H:\ drive access purposes, your username must include the 
preceding full stop and your password is the same as your current Novell Login 
Password – the one you use to access the computers in College - NOT you email 
access password. 
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Using Web-Based H:\ Drive Access 

Once you have logged in, you will be taken to the NetStorage screen, like that shown 
below: 

 

The contents of your H:\ drive are held in the DriveH@EnrolmentNumber folder.  This can 
be viewed by selecting the DriveH@EnrolmentNumber option from the list on the left hand 
side of the screen and your folders and files will then be displayed on the right of the 
screen.  To view the contents of a particular folder, select that folder from the list on the left 
and its contents will then be displayed on the right. 

Before you can edit a file, you must first download it to the machine that you are currently 
working on.  This can be done by clicking in the small box next to the file you wish to 
download so that a tick appears within it, and then selecting the Download option from the 
File menu. 
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This will bring up a download window asking what you would like to do with the selected 
file.  Select the Save option to save the file to the local computer. 

 

Now specify a location where you would like the file to be saved.  You can also change the 
name of the file if you wish.  When you have finished, select Save to save the file. 

 

When the file has been saved to the required location, the following screen will be 
displayed.  Select the Close option to return to the NetStorage screen. 

 

You can now open and edit the downloaded file in the usual manner.  Once you have 
finished editing the file and have saved it, you then need to upload it back to your H:\ drive.  
This can be done by browsing to the folder in which you wish to place your file within the 
main NetStorage screen, and then selecting the Upload option from the File menu.  
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This will bring up an upload window asking you to specify the location of the file to be 
uploaded.  This can be done by selecting the Browse option.  

 

Now locate the file you wish to upload.  Once you have selected the file to be uploaded, 
click on the Open button.   

 

Now select the Upload button to upload the file to your College H:\ drive.  NB - If the tick is 
left in the Overwrite Existing Files option above the upload button when this is selected, 
any file of the same name within the same folder on your H:\ drive will be overwritten! 
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You can check that the file has been uploaded correctly by viewing its details within the 
main NetStorage window.  These include the date and time each file was added to your 
H:\ drive or last edited and are displayed under the Modified column as shown below. 

 

Exiting Web Based H:\ Drive Access 
To exit your web-based H:\ drive, click on the Logout icon at the top of the screen.  This 
will log you out of your H:\ drive access securely and exit the NetStorage system.  

 

More information on using NetStorage is available from the Help menu. 
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Accessing Email 

All students at the College have their own individual College email accounts.  Your College 
email address takes the form of your enrolment_number@huddcoll.ac.uk – for example: 

1111111@kirkleescollege.ac.uk 

Your email account can only be accessed through the Internet, either in College or at 
home.  This can be achieved by opening a Web Browser (e.g. Internet Explorer) and going 
to the following site. 

http://www.kirkleescollege.ac.uk 

From here, select the Email link in the top right hand corner of the page and this will take 
you to the GroupWise WebAccess login screen, as shown below. 
 

 

In order to access your email account, you will need to enter a Username and Password 
and then click on Login.  Your email username and password are: 
 

Username = Enrolment Number 

Password = Date of Birth 

Remember:  For password purposes, your date of birth is entered as a six figure 
number - for example the 8th October 1980 should be entered as 081080.  Your email 
password will remain as your date of birth, even after you have changed your main 
computer account login password. 

 



                                                                                                    IT SUPPORT UNIT 

Student Email Accounts 

Student Network Handout                                                                                                              2008/2009   18 

Using Email 

Once you have logged in, you will be taken to your mailbox screen, similar to that below: 

 

Your mailbox contains all the email messages that you have received, displayed with their 
Sender, Subject and Date.  From your mailbox you can read, send, receive and manage 
your emails.   

 

NOTE – All College email accounts and their contents will be deleted  
at the end of the College’s Academic Year on 1st July 2009. 

 

Reading Emails 

To read an email you have received, just double-click on the emails’ Subject and the 
message will open: 

 

You can now read the email and then reply to it, print it, or forward it to someone else!  To 
close the email, just click on the cross in the top right hand corner of the window as usual. 
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Printing Emails 

To print an email message, the email must first be opened as above.  Once you have 
opened your email, click on the File menu and select Print.  Check to make sure that you 
are printing only one copy of the email and then select Print again. 

 

Replying To Emails 

The easiest way to send an email is to reply to one that someone has already sent to you.  
This is because the computer will then put the recipients email address into the To: field 
for you.   

To reply to an email, open the email and then click on the Reply button at the top of the 
window.  A reply email window will open with the senders name, recipients email address 
and email subject already in place.  All you need to do now is to type your 
response/message into the blank page and change the email subject as appropriate.   

 

When you have completed your message, just click on the Send button to send the email! 
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Sending New Emails 

To send an email when you are not replying to one you have received is a little bit more 
complicated.  To start a new email click on the New… icon at the top left of your mailbox 
screen. 

 

A new email window will open like that below with all the fields (boxes) empty ready for 
you to complete.   

 

If you have not sent this person an email message from this mailbox before you will need 
to type in their full email address, very carefully, into the To: field.  Email addresses are 
usually entered in lower case and have to be exact.  If you have sent this person an email 
from this mailbox before, you should be able to select their email address from your 
Address Book (see next section).  If you want to send the same email to more than one 
person, you can put the other recipients’ email address in the CC: field. 

Once you have entered the recipients email address, you can then give the email 
message a Subject.  This should be a short description telling the recipient what the email 
is about.  Now you are ready to type your message into the blank page.  When you have 
completed your message, just click on the Send button to send the email! 
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Using the Address Book 

When you send a person an email, their email address is usually added to your Address 
Book.  Next time you want to send that person an email, you can just select their address 
from the Address Book without having to type it again.  To access the Address Book when 
sending a new email, click on the Address Book button at the top of the new mail screen.  

 

This will open the Address Book window shown below. 

 

Check that the Address Book option at the top is set to either the your name or the 
Frequent Contacts address book as required, and then use the Search options to find 
the person you are looking for.  Once you have found them, click in the small box next to 
their name to select them, then click on the To button above the list and the recipients 
email address will appear in the right hand column.  Now click on OK to return to your new 
email message and their address will be displayed in the To: field of the email message 
screen. 
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Deleting Emails 

Although you may want to keep some of your emails, you will receive others that you do 
not want/need to keep.  To delete these emails, click in the small box next to each email 
you want to delete so that a tick appears within it and then select the Delete button at the 
top of the mailbox.   

 

Emails that are deleted do leave your mailbox immediately; they go into the Trash Can in 
case you have deleted them by mistake.  To empty the Trash can once you are sure you 
do not need the emails anymore, click on the Trash Can icon at the bottom of the mailbox 
list. 

 

 

This will open the Trash Can window and show you all the emails currently in your Trash.  
To delete all the emails within the Trash, click on the Empty Trash button at the top right 
hand side of the screen. 

 

Emails can also be recovered from the Trash if deleted by mistake.  To recover an email, 
click in the small box next to the email to be recovered so that a tick appears within it and 
then select the Undelete button at the top of the mailbox screen.  The email is then 
transferred back to where it was deleted from. 

Exiting Your Email 
To exit your email mailbox, click on the Logout option at the top of the screen.  This will 
log you out of your email and exit the GroupWise WebMail system.  
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Email Attachments 

As well as sending messages, it is also possible to send computer files using email.  
Files sent in this way are called attachments.  It is possible to attach many different 
types of files to email messages - including letters, forms, photographs, pictures and 
sounds.  You should only access email attachments sent by people you know and trust 
to try to avoid catching computer viruses. 

Receiving Attachments 

It is possible to see whether an email you have received has an attachment by looking 
at your Mailbox.  Emails with attached files are displayed with a small paperclip showing 
next to their Subject. 

 

To look at an attachment, first open the email as usual.  You should now see a screen 
similar to that below which shows the name of the attached file and a set of options for 
viewing, opening and saving the attachment. 

 

Many attached files can be viewed easily by selecting View.  Selecting Open opens the 
attachment within the application (MS Word, MS Excel etc.) that it was created.  In order 
for this to happen, the computer you are trying to access the attachment on must have 
the appropriate software installed – you cannot open a spreadsheet created in MS 
Excel on a computer that does not have MS Excel installed on it!  This is something to 
think about when sending and receiving files by email.   
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Saving Attachments 

It is also possible to save the attached files you receive by email so that you can 
alter/update them or look at them later.  To save an attachment first select Save, then 
click on Save to confirm your choice when you see the screen below.  Again you should 
only save email attachments sent by people you know and trust to try to avoid catching 
computer viruses. 

 

Now specify a location where you would like the file to be saved.  This can be on your 
H:\ drive if in College, or in your My Documents folder at home.  You can also change 
the name of the file if you wish.  When you have finished, select Save to save the file. 

 

When the attached file has been saved to the required location, the following screen will 
be displayed.  Select the Close option to return to your email. 
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Sending Attachments 

As well as receiving attachments, you can also send them.  To attach a file to an email, 
prepare a new email message in the usual way and then select the Attachments tab 
above the senders name to access the screen below. 

 

Click on Browse button and then locate the file you wish to attach to your email.  This 
could be on your H:\ drive if in College, or in your My Documents folder when at home.  
Once you have selected the file to be attached, click on Open.   

 

Now select Attach to attach the file to your email message.   
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Finally click on the Mail tab to return to your mail message. 

 

You can check that the file has been attached, and that it is the correct file name, by 
looking at the attachments information displayed above the main message window as 
shown below.   

 

Once you are happy that the message and attachment/s are correct, you can select 
Send in the usual manner to send the email. 
 


